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NEW QUESTION 1

- (Exam Topic 1)

You need to embed the check-in solution into the communication solution. To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

What must you use to embed the check-in solution? v
Visual Studio
Power Apps Web Studio
Al Builder
Common Data Service
Where must the check-in solution be available within the v
communication solution? chat section of the solution

Microsoft 365 Apps selection grid
in an embedded webpage
in a tab

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Graphical user interface, application, Word Description automatically generated
Box 1: Power Apps Web Studio

Scenario: The check-in solution must continue to function if there are internet issues. If the self-service kiosks are not available, staff must be able to use the check-
in solution from within their communication solution.

PowerApps Studio is a browser application used to edit your apps. PowerApps Studio includes a

drag-and-drop canvas in the center of the screen and a screen or object list pane on the left. Properties, Rules, and Advanced Properties for selected screens or
controls are displayed in the right pane.
Box 2:in atab

You can customize the Teams experience by adding Power Apps canvas apps to your channels in Teams using the PowerApps tab.

NEW QUESTION 2

- (Exam Topic 1)

You need to design and create the solution for gathering contact information from guests for marketing purposes.

What should you use? To answer, select the appropriate options In the answer area. NOTE: Each correct selection is worth one point.

Action Solution

Extract business card data v

Al Builder

Common Data Service
Power Virtual Agents
Power Automate

Implement the contact gathering solution v

Create a new entity extraction component.
Integrate the solution with Azure Cognitive Semvices.
Use a prebuilt Al model.

A. Mastered
B. Not Mastered

Answer: A

Explanation:
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Action Solution

Extract business card data o v
Al Builder'

Common Data Service
Power Virtual Agents

Fower Automate

Implement the contact gathering solution v
Create a new entity extraction component.
Hntegrate the solution with Azure Cognitive Services.
Use a prebuilt Al model. !

NEW QUESTION 3
- (Exam Topic 1)
You need to create the FAQ solution content What should you do first?

A. Al Builder

B. Suggest topics
C. Automate

D. Trigger phrases

Answer: B

Explanation:
You need to make sure there are three main steps need to do while doing import FAQ and add the topic to your bot application.

> Import Suggested Topics from FAQ webpage.
> Add a topic.

> Enable the topics Reference:
https://social.technet.microsoft.com/wiki/contents/articles/53820.power-virtual-agents-fag-chatbot.aspx

NEW QUESTION 4

- (Exam Topic 1)

You need to design the chat solution to answer the inquiry from Guestl.

Which three components can you use? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.

A. Variables

B. Escalations
C. Smart match
D. Synonyms
E. Topics

Answer: ACD

Explanation:

Scenario: Guestl inquires about snow conditions several times during each day of their stay.

Variables let you save responses from your customers in a conversation with your bot so that you can reuse them later in the conversation.

Synonyms allows you to manually expand the matching logic by adding synonyms. Smart match and synonyms seamlessly work together to make your bot even
smarter.

Reference:

https://docs.microsoft.com/en-us/power-virtual-agents/authoring-variables

https://docs.microsoft.com/en-us/power-virtual-agents/advanced-entities-slot-filling

NEW QUESTION 5
- (Exam Topic 1)
You need to design the resort portal’s email registration process. Which solution should you use?

A. Default the invitation code from the email upon logging into the portal

B. Auto-populate the invitation code field on the sign in screen from the email link
C. Embed the invitation code in the email link URL

D. Send the customer their username and temporary password in the email link

Answer: C

Explanation:

Scenario: Guests must receive a separate email to verify proof of ownership for their registration. Note: You can setup redeem an invitation code for power apps
portal.

Reference:
https://carldesouza.com/how-to-setup-redeem-an-invitation-code-for-power-apps-portal/

NEW QUESTION 6
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- (Exam Topic 2)

You need to set up the new service request completion process.

Which two components should you include in the solution? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.

A. connection reference

B. business process flow
C. Power Automate flow
D. connection

Answer: AC
Explanation:

Reference: https://docs.microsoft.com/en-us/power-apps/maker/data-platform/create-connection-reference

NEW QUESTION 7
- (Exam Topic 2)
You need to implement the requirement for the VP of sales. What should you do?

A. Use a test account with a base security role with QV security added.
B. Add the System Administrator security role to your user account.

C. Use a test account with only QV security added.

D. Add QV security to your user account.

Answer: A

Explanation:

A VP of sales requires a test environment to demonstrate to potential clients the security policies that are included in their initial offering.
Currently, testing the new QV functionality outside the development environment is not possible due to corporate security policies requiring the same security role

across all environments.

Note: One of the security best practices in Dynamics 365 is to use the base security role as a baseline and apply that role to all Users. The base security role will

include all the common/basic permissions that are required to have access to the system.
To set up the base security role for the first time

> create a new empty security role.

> add the minimum privileges required to access the system.
> add the privileges required for the basic functionalities.

> test the role with the test user account.

> add the permissions to the entities that all users can access (e.g. reference data).
Reference: https://linnzawwin.blogspot.com/2020/07/minimum-privileges-required-to-log-in.html

NEW QUESTION 8
- (Exam Topic 2)

You need to configure a Power Automate flow to send the email with the results to the client. What should you use? To answer, select the appropriate options in

the answer area.
NOTE: Each correct selection is worth one point.

Trigger settings

v

Set Table name to Qualification and Column filter to statecode.
Set Table name to Qualification and Column filter to statuscode.
Set Table name to Service Requests and Column fiiter to statuscode.

Logic to complete service requests

Complete if current record is in Complete status.
Compiete if current record is in Pending Verification status.

Loop through related qualification records and complete if all are in Complete status.

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Box 1: Set Table table to Qualification and Column filter to statuscode.

Box 2: Loop through related qualification records and complete if all are in Complete status. The new process for completing a service request must automate the

following:
Set the Service Request record status to Complete when work on all Qualification records is finished.

Send an email to the client with the results when the service request is completed. The email must list each qualification as either Valid or Not Valid, depending on

the verification.
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NEW QUESTION 9

- (Exam Topic 2)

You create a desktop flow to interact with a certification authority’s website. You need to get data in and out of the desktop flow.
How should you set up the input and output parameters? To answer, select the appropriate options in the answer area.

NOTE: Each correct selection is worth one point.

Parameter direction Configuration

Inbound

Copy and paste qualification data into the desktop flow.
Run a cloud flow from the Dataverse qualification record to send data to the desktop flow.
Connect by using the Dataverse connector from the desktop flow and retrieve the qualification data.

Qutbound

Copy and paste the verification data into the qualification record.

Send data from the desktop flow to a cloud flow to update the gqualification record.

Connect by using the Dataverse connector from the desktop flow and the qualification record
A. Mastered

B. Not Mastered
Answer: A

Explanation:

Box 1: Connect by using the Dataverse connector from the desktop flow and retrieve the qualification data. All information sent by clients for services is stored in
Microsoft Dataverse with a model-driven app as the

interface.

Quialification verification

The qualification table contains details about an individual school degree, professional qualifications, and other qualifications that must be verified.

A service request can have one or more Qualification records associated with it.

Record status is pending verification until the initial team member finishes, at which point the member changes the status to Complete.

When all qualification records related to a service request are verified either by manual or automated processes, the results are made available to ADatum
Corporation’s client.

In the rare event that results are questioned, a new service request is created and verified independently of the previous work that took place.

Box 2: Send data from the desktop flow to a cloud flow to update the qualification record. To complete a service request, users perform the following actions:
Send a templated email by using Microsoft Outlook to the client after all qualifications for a service request are checked.

Change the service request status to Completed. Currently, service requests do not indicate when all Qualification records are addressed.

NEW QUESTION 10
- (Exam Topic 2)
You need to capture the Date Completed value from the website using a desktop flow. Which method should you use?

A. Use optical character recognition (OCR) on the screen to locate and extract the value.
B. Display an input dialog and prompt the user to enter the value.

C. Extract the value from the window the browser is using.

D. Retrieve the value from the HTML element in the webpage.

Answer: C

Explanation:
Record the name of the QV team member who performed the work and the date completed.

NEW QUESTION 10

- (Exam Topic 2)

You need to configure a Power Automate flow to send the email with the results to the client. What should you use? To answer, select the appropriate options in
the answer area.

NOTE: Each correct selection is worth one point.

Requirement Control
Process qualification records for a v
service request. Switch

Condition

Apply to Each

Evaluate a qualification. v

Do until
Condition
Apply to Each

A. Mastered
B. Not Mastered
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Answer: A

Explanation:

Box 1: Apply to each

You can use the Apply to each action to process a list of items periodically. Box 2: Do until

The Do Until control in Power Automate is a loop that repeatedly forces an action until a certain condition becomes true.

Reference: https://docs.microsoft.com/en-us/power-automate/apply-to-each https://blog.enterprisedna.co/do-until-loop-control-in-power-automate/

NEW QUESTION 11

- (Exam Topic 2)

You need to be able to move a Power Automate desktop flow used in the verification process to the testing environment.
What should you do?

A. Share a copy of the desktop flow with a member of internal IT.

B. Use the Export option in the flow to get the flow identifier and provide it to internal IT.
C. Send a copy of the desktop flow to a member of internal IT.

D. Create the desktop flow in a solution and provide it to internal IT.

Answer: D

Explanation:

Internal IT reports that the solution import to the test environment failed because of missing dependencies related to the flow for completing service requests.
Flows with PowerApps steps

Flows that were created via Power Automate in the PowerApps menu or flows that have PowerApps steps added have a different issue then other Power
Automate flows. As of the writing of this blog these flows are not able to be imported into another environment. This means that if you create flows with Power
Apps steps within them you will need to recreate them in your destination environment.

Reference: https://www.spyglassmtg.com/blog/power-platform-solution-export-and-import-issues

NEW QUESTION 12

- (Exam Topic 3)

You create a parent entity and a child entity. The parent entity has a 1:N relationship with the child entity.

You need to ensure that when the owner changes on the parent record that all child records are assigned to the new owner.
You need to configure the relationship behavior type. What should you use?

A. Parental

B. Referential, Restrict Delete
C. Referential

D. Restrict

Answer: A

Explanation:

https://docs.microsoft.com/en-us/dynamics365/customer-engagement/customize/create-and-edit-1n-relationship A parental table relationship is any 1:N table
relationship where one of the cascading options in the Parental column of the following table is true.

Graphical user interface, application Description automatically generated

Action Parental Mot Parental

Assign .ascade A _ascade NMone

Delete _ascade A

Reparent _ascade A

Unshare _ascade A _ascace Mo

Reference:
https://docs.microsoft.com/en-us/powerapps/maker/data-platform/create-edit-entity-relationships

NEW QUESTION 17

- (Exam Topic 3)

You are creating tables for use with Microsoft Power components.

The display names of the tables must not be changed when the solution is promoted to the user acceptance testing environment.
You need to apply this restriction to the solution, Where should you make the changes?

A. Power Apps
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B. Default solution

C. Segmented solution
D. Unmanaged solution
E. Managed solution

Answer: C

NEW QUESTION 21

- (Exam Topic 3)

You are a Dynamics Sales administrator for a car dealership. The dealership uses only out-of-the-box functionality. When a new car is sold, the salesperson uses
a Word template to generate a letter from the quote to thank the customer.

You need to determine if you can revise the template. Which Word template change can you make?

A. Add the Discount field conditionally.

B. Format the table to have alternating color rows.

C. Format the Created On field to a long date format.

D. Add the address of the customer.D18912E1457D5D1DDCBD40AB3BF70D5D

Answer: D

NEW QUESTION 24

- (Exam Topic 3)

You are a Dynamics 365 Customer Service developer. A salesperson creates a chart.

You need to ensure that the chart is available to all users on the team. What should you do?

A. Share the chart with the team.

B. Assign the chart to each person on the team.
C. Export the user chart to Power B

D. Import the chart as a Power BE visualization.
E. Export the user chart for import as a user chart.

Answer: A

NEW QUESTION 29

- (Exam Topic 3)

You plan to implement Microsoft Dataverse.

You must track changes for two columns in the Account table. You must maintain a historical log of changes for the two columns and track only what is necessary.
You configure the appropriate organization settings.

You need to configure the system to track changes for the two columns.

Which two actions should you perform? Each correct answer presents part of the solution.

NOTE: Each correct selection is worth one point.

A. Enable auditing for the Account table.

B. Enable auditing for the two specific columns.

C. Enable change tracking for the Account table.

D. Enable change tracking for the two specific columns.

Answer: AB

Explanation:

By setting the IsAuditEnabled property of a table’s definition and the IsAuditEnabled property of each desired column’s definition to true, data changes to records
of those tables can be logged by the platform.

Note: There are three levels where auditing can be configured: organization, table, and column. The organization level is the highest level, followed by the table
level, and finally the column level. For column auditing to take place, auditing must be enabled at the column, table, and organization levels. For table auditing to
take place, auditing must be enabled at the table and organization levels.

Reference:

https://docs.microsoft.com/en-us/powerapps/developer/data-platform/configure-entities-attributes-auditing

NEW QUESTION 30

- (Exam Topic 3)

You set up a new instance of Dynamics 365 for Customer Service. Users report a variety of issues working with cases on mobile devices. You need to configure
the mobile app to be able to view cases. NOTE: Each correct selection is worth one point.
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Scenario Action needed

Users cannot see case records on mohile Y

devices. Configure mobile settings set on the case entity level
Configure mobile settings at the field level within the case form.

Configure a security role in the mobile permission set for appropnate users.

Users can open cases but cannot see the "'
subject of the case Configure mobile settings set at the case entity level

Configure mobile settings at the hield level within the case form

Configure a security role in the mobile permission set for appropriate users.

Users report that they cannot access the

v

system from the Dynamics 365 mobile
in Contigure mobile settings set at the case entity level,
djd}

Configure mobile settings at the tield level within the case form

Configure a security rale in the mobile permission set for appropriate users

A. Mastered
B. Not Mastered

Answer: A

Explanation:

* 1. User is able to login but can't see Case Records --> "Configure Mobile Settings on Case Entity Level"

* 2. Users can open cases but cannot see the subject of the case - “configure mobile settings at the field level within the case form

* 3. User reports that they cannot access the system from Dynamics 365 mobile app --> Configure a security role in the mobile permission set of the appropriate
user

https://docs.microsoft.com/en-us/dynamics365/customer-engagement/mobile-app/set-up-dynamics-365-for-phon

NEW QUESTION 32

- (Exam Topic 3)

You create a report by using Power Bl Desktop and a Power Bl dataset that is connected to Azure SQL Database.
Multiple groups of employees will use the report.

You need to ensure that each group of employees can see only data that pertains to their group. What should you do?

A. Create and assign file security profiles.
B. Create and assign Common Data Service security roles.
C. Create and assign roles by using row-level security.

Answer: C

Explanation:
Reference:
https://docs.microsoft.com/en-us/power-bi/collaborate-share/service-share-dashboards

NEW QUESTION 33

- (Exam Topic 3)

A company creates a Microsoft Power Apps app through the Power Apps designer portal for use in Microsoft Teams.

This app needs to be promoted to the user acceptance testing environment.

You need to complete the Microsoft recommended actions before you export the solution. Which two actions should you complete? Each correct answer presents
part of the solution. NOTE: Each correct selection is worth one point.

A. Write validation tests.

B. Set the Optimized embedding appearance field to true.
C. Publish all changes.

D. Run the solution checker.

E. Clone a solution.

Answer: DE

Explanation:

The Power Apps solution checker performs a rich static analysis check on your solutions against a set of best practice rules to quickly identify problematic patterns.
After the check completes, you receive a detailed report that lists the issues identified, the components and code affected, and links to documentation that
describes how to resolve each issue.

The solution checker analyzes these solution components: Common Data Service plug-ins

Common Data Service custom workflow activities

Common Data Service web resources (HTML and JavaScript) Common Data Service configurations, such as SDK message steps

Reference: https://www.eimagine.com/ui/

NEW QUESTION 37

- (Exam Topic 3)

A company deploys several model-driven apps. The company uses shared devices in their warehouse. The devices are always powered on. Users log on to the
devices and then launch the apps to perform actions.
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Unauthorized users recently uploaded several files after another user failed to log out of a device. The company needs to prevent these incidents from occurring in

the future.
You need to configure the solution to prevent the reported security incidents. What should you do? To answer, select the appropriate options in the answer area.

NOTE: Each correct selection is worth one point.

Requirement Action

Prevent unauthonzed access to devices. ! v
Set an inactmty limit in the user's group policy
Set a timeout in the Power Platform admin center
Configure access controls in Azure Active Directory

Configure a Power Automate flow to poll for user inactivity on the devices.

Prevent users from uploading a specific type of file. Y

Enter the restricted file types in the SharePoint admin center
Enter the allowed file types in the Power Platform admin center,

Enter the restricted file types in the Power Platform admin center.

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Graphical user interface, text, application Description automatically generated

Box 1: Set a timeout in the Power Platform admin center.

To enforce users to reauthenticate after a pre-determined period of time, admins can set a session timeout for their individual environments. Users can only remain
signed in the application for the duration of session. The application signs out the user when the session expires. Users need to sign in with their credentials to

return to customer engagement apps.
Note: Configure session timeout

> In the Power Platform admin center, select an environment.
> Select Settings > Product > Privacy + Security.

> Set Session Expiration and Inactivity timeout. These settings apply to all users.
Incorrect:
Configure inactivity timeout

> In the Power Platform admin center, select an environment.
> Select Settings > Product > Privacy + Security.

> Set Session Expiration and Inactivity timeout. These settings apply to all users. Box 2: Enter the restricted file types in the SharePoint admin center.
To block uploading of specific file types

> Go to the Settings page of the new SharePoint admin center,

> Select Sync.
Graphical user interface, text, application Description automatically generated

Sync

> Select the Block upload of specific file types check box.
> Enter the file name extensions you want to block, for example: exe or mp3.

D’ Select Save.

Reference:
https://docs.microsoft.com/en-us/power-platform/admin/user-session-management https://docs.microsoft.com/en-us/onedrive/block-file-types

NEW QUESTION 39
- (Exam Topic 3)
A company has a canvas app that includes the following screens: Screenl and Screen2. The OnVisible property for Screenl contains the following expression.
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Set(AgeGroups, ['1-25", "26-54", "55+"])
For each of the following statements, select Yes if the statement is true. Otherwise, select No. NOTE: Each correct selection is worth one point.

Statements Yes No
AgeGroups can be accessed from Screen1 and Screen2. @, O
AgeGroups is a collection @ O
You can use the Update function to change values in AgeGroups. O O
A. Mastered
B. Not Mastered
Answer: A
Explanation:
Statements Yes No
AgeGroups can be accessed from Screen1 and Screen2. O i____Dj'
AgeGroups is a collection O 'O,
You can use the Update function to change values in AgeGroups. | O | O

NEW QUESTION 42

- (Exam Topic 3)

You are modifying a model-driven app. You set up a customer table in Microsoft Power Platform to retrieve user data. You set up a form with the following columns
for users to enter their data. The form includes the following columns:

Column Data type
Country/region Choices (multi-select)
Passport ownership Choice (yes /no)
Passport expiration date Text

The form must do the following:

» The Country/region column must automatically populate with US when English is chosen as a language. If the user selects Other for this column, the column
must remain blank so that user can enter a value.

» The Passport expiration date column must appear only if the user selects Yes in the Passport ownership column.

You need to configure the app with the least amount of effort.

What should you configure? To answer, drag the appropriate solution component to the correct requirements. Each solution component may be used once, more
than once, or not at all. You may need to drag the split bar between panes or scroll to view content.

NOTE: Each correct selection is worth one point.

Salution components fArawer frca

P——— st P aguibd & v Sorlaithief COMEREnT

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Graphical user interface Description automatically generated with low confidence

NEW QUESTION 46

- (Exam Topic 3)

You create a new Power Virtual Agents chatbot for an organization. Testing and production deployment of the chatbot are not complete. You need to ensure that
appropriate users can access the chatbot.

Which methods should you use? To answer, select the appropriate options in the answer area.

NOTE: Each correct selection is worth one point.
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Answer Area
Requirement Method

Test the chatbot with unlicensed internal users v
Use the demo website
Share the chatbot to each user individually
Share the chatbot to a security group containing all users

Allow other licensed internal users 1o adit the chatbot v
Share the chatbot to each user individually
Share the chatbot to a security group containing all users
Deploy the chatbot to Microsoft Teams in your tenant

Deploy the chatbot to preduction for public consumption v
Embed the chatbot code in an IFrame on your company's public website
Deploy the chatbot to Microscft Teams in your tenant
Deploy the chatbot to AppSource

A. Mastered

B. Not Mastered
Answer: A

Explanation:

Graphical user interface, application Description automatically generated

Box 1: Use the demo website

When publishing the bot to the web, you can publish to a prebuilt demo website (which you can use to share the bot with your teammates and stakeholders) and to
your own live website.

Box 2: Share the chatbot to a security group containing all users.

A license for each user, also known as a "per user license" (or "Power Virtual Agent User License" as referred

to on the Microsoft 365 admin center), should be assigned to individual users who need access to create and manage chatbots.

To simplify user license management, you can assign licenses to an Azure Active Directory (Azure AD) security group.

Box 3: Embed the chatbot code in an IFRame on your copany's public website

You can add your bot to a live website as an IFrame. Your live website can be a customer-facing external website or an internal site, like a SharePoint or Yammer
site.

Reference:

https://docs.microsoft.com/en-us/power-virtual-agents/publication-connect-bot-to-web-channels https://docs.microsoft.com/en-us/power-virtual-
agents/requirements-licensing

NEW QUESTION 49
- (Exam Topic 3)
A company plans to automate the following manual processes by using Power Automate. You need to identify Ul flow types for the two business processes.

Process | Time to Complete Comments
1 | 30 minutes The user's device must remain unlocked when the business process runs. The user will be required to leave their
device unattended in a secure setting while the business process runs so that the user can assist with other
efforts.
2 | 45 minutes The process must run after normal business hours, The device that runs the business process must remain
| unlocked when the business process 1s not running

Which desktop flow type should you use? To answer, drag the appropriate desktop flow types to the correct business processes. Each desktop flow type may be
used once, more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

Diesictop flow types Answer Area
Altended Lnatenged Business process Desktop flow type
exkiop fow type
A. Mastered

B. Not Mastered
Answer: A

Explanation:
Graphical user interface, application Description automatically generated
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NEW QUESTION 52

- (Exam Topic 3)

You configure an alert in Power BI.

You need to alert users when the value of a tile exceeds a threshold. To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

Where should you configure the Power Bl alert so that it v
tnggers the process? Power Bl

Common Data Service

Power Automate

Fower Bl admin portal

Who can see alerts configured for Power BI? v
The person who created the alert

The dashboard owner and the person who created the alert.
Everyone who has access to the dashboard.

Everyone who has access to the Power Bl instance

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Reference:
https://docs.microsoft.com/en-us/power-bi/create-reports/service-set-data-alerts

NEW QUESTION 55

- (Exam Topic 3)

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some guestion sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

You are creating Power Virtual Agents chatbot that captures demographic information about customers. The chatbot must determine the group a customer belongs
to based on their age. The age groups are:

> 0-17

> 18- 25

> 26-35

> 36-55

> 55-100

You need to configure the chatbot to ask a question that can be used to determine the correct age group. Solution: Use Date and time for Identify in the question
and then add branches that use conditional logic to

determine the age group.
Does this meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 60

- (Exam Topic 3)

A company creates a Power Virtual Agents chatbot.

You need to determine when live agents are engaged to provide support.

Which metrics should you use? To answer, drag the appropriate metrics to the correct processes. Each metric may be used once, more than once, or not at all.
You may need to drag the split bar between panes or scroll to view content.

NOTE: Each correct selection is worth one point.

Metrics Answer Area
Engagement over ime Process Metric
Session outcomes over time Determine which topics are transferred to live Metric

agents most often

Escalation rate dnvers
Determine the number of chats per day that Metric

. are transferred to live agents
Escalation rate -

A. Mastered
B. Not Mastered
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Answer: A

Explanation:

Reference:

https://docs.microsoft.com/en-us/power-virtual-agents/teams/analytics-summary-teams

NEW QUESTION 65
- (Exam Topic 3)

A company has employees in France, Mexico, and the United States. You are creating a Power Apps app to allow users to add client records to Microsoft
Dataverse. The default language for the company is English.
The company wants the app to display each local language. You need to add the Spanish and French languages.
Which four actions should you perform in sequence for each language? To answer, move the appropriate actions from the list of actions to the answer area and
arrange them in the correct order.

Actions

Import the solution.

Export translations.

Replace the language code column and translated
wording in the CrmTranslations.xml file.

Select an unmanaged solution.

Select a managed solution.

Add a language code column and translated wording in

the CrmTranslations.xml file.

Import translations.

Export the solution.

A. Mastered

B. Not Mastered

Answer: A

Explanation:

Step 1: Select an unmanaged solution. Export the localizable text
The scope of the localizable text that will be exported is the unmanaged solution that contains the localizable text.

> From Power Apps, select Solutions.

Answer Area

> In the All Solutions list, select the unmanaged solution that contains the localizable text you want.

> On the command bar, select Translations > Export Translations.

Step 2: Export translations.
Step 3: Add a language code column and a translated wording in the CrmTranslations.xml file. Get the localizable text translated
You can send this file to a linguistic expert, translation agency, or localization firm.
If you have the knowledge to translate the text, or if you just want to see the format, you can extract the zip file that you exported you will see that it contains two

XML files.

[Content_Types].xml CrmTranslations.xml
You can open the CrmTranslations.xml file with Microsoft Office Excel. When you view the data in Excel, look at the Localized Labels tab.
Graphical user interface, text, application, table, Excel Description automatically generated

A

1 Entity nam Object 1D

642 account
643 account
644 account
645 account
646 account
647 account
cr2b3_car
649 crab3_car
650/cr2b3_car
651 cr2b3_car
652 cr2b3_car
653 crzb3_car
654 crlbl_car
655/cr2b3_car
656 cr2b3_car
657 cr2b3_car

Any custom tables or columns will have empty cells for the localizable text. Add the localized values for those items.
Step 4: Import translations. Import the localized text

74a622c0-5193-de11-97d4-00155da3b01e
74a622c0-5193-del1-97d4-00155da3b01e
a3a%eed7-5093-dell-97d4-00155da3b0le
ada9eed7-5093-dell-97d4-00155da3bl1e
5b290fff-355f-df11-ae90-00155d2e3002
5b290fff-355f-df11-a290-00155d223002
99a0f788- 3f64-e811-2957-000d3af3b3af
99a0f788-364-2811-2957-000d 3af3b3af
99a01788-3164-e811-2957-000d 3af3b3af
bedlebec-cod9-4211-847e-61245a489130
bEdlebec-cod9-42f1-84Te- 512452489130
d3aalfod-5e88-40ec-afgd-Oel13efeBleaa
d3aalfod-5e88-40ec-afed-Oellefelleaa
21a1f788-3164-2811-2957-000d3af3b3af
21a1f788-3f64-0811-2957-000d 3af3b3af
1da1f788-3164-2811-2957-000d3af3b3af

Information Display Stnings

Localized Labels

Importing the text requires compressing the files and importing them into the system. Import the files
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From the same unmanaged solution that you exported the translations from, in the menu choose Translations > Import Translations.

Note: If you have customized table or column text, such as column labels or drop-down list values, you can provide the users in your environment who are not
working with the base language version of your environment with this customized text in their preferred languages.

The process has the following steps:

> Enable other languages for your environment
> Export the localizable text
> Get the localizable text translated

> Import the localized text
Reference: https://docs.microsoft.com/en-us/power-apps/maker/model-driven-apps/translate-localizable-text

NEW QUESTION 68

- (Exam Topic 3)

You need to build a Power Bl dashboard for sales managers to track opportunities.

When a new sale closes that is greater than S1 million, a notification must pop up and an email must be sent to the leadership team.
You need to ensure the email is sent without editing the Microsoft Dataverse.

Which two elements should you configure? Each correct answer is part of the solution. NOTE: Each correct selection is worth one point.

A. alerts in Power Bl

B. a calculated column in the Dataverse

C. a custom connector

D. a paginated report to save to Microsoft OneDrive
E. a Power Automate flow

Answer: AE

Explanation:

In order to build a Power Bl dashboard for sales managers to track opportunities and send notifications and emails when a new sale closes that is greater than S1
million, you should configure:

* A. alerts in Power Bl: You can set up alerts in Power Bl that will trigger when a specific condition is met. For example, you can set an alert to trigger when the
value of a specific field in the "Opportunities” table exceeds $1 million.

* E. a Power Automate flow: To send an email to the leadership team when an alert is triggered, you can create a Power Automate flow that is triggered by the
Power Bl alert. The flow can then use the "Send an email" action to send an email to the leadership team with the necessary information about the sale that
exceeded $1 million.

References:

> https://docs.microsoft.com/en-us/power-bi/transform-model/desktop-alerts
> https://docs.microsoft.com/en-us/power-platform/admin/alerts-overview

NEW QUESTION 72

- (Exam Topic 3)

A company has locations in the United States, Brazil, India. and Japan. The company conducts financial transactions in all of these regions.
Financial transactions in Brazil are going to stop, but the office will remain open.

Users must longer be able to create records associated with the Brazilian currency. Historical records must remain intact

You need to configure Microsoft Dataverse to meet the requirement

What should you do?

A. Rename the Brazilian currency.

B. Delete the Brazilian currency record.

C. Disable the Brazilian language pack

D. Deactivate the Brazilian currency record.

Answer: D

Explanation:

You can't delete currencies that are in use by other records; you can only deactivate them. Deactivating currency records doesn't remove the currency information
stored in existing records, such as opportunities or orders. However, you won't be able to select the deactivated currency for new transactions.

Reference:

https://docs.microsoft.com/en-us/power-platform/admin/manage-transactions-with-multiple-currencies

NEW QUESTION 73

- (Exam Topic 3)

You use Power Virtual Agents to create a bot that will answer and transfer help desk calls.

You create topics that contain nodes and functions. The company has the following requirements for the bot:

* When a caller states the word issue, help, or problem, the bot must respond with the question. "How can we help you today?"

* When the bot responds with the question, "How can we help you today?", the bot must provide the caller with the choices of hardware, software or other
» When the caller asks a question, the bot must save the response so that it can perform an action on the

response.

You need to configure the bot.

Which nodes or functions should you use? To answer, select the appropriate options in the answer area.
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Answer Arca

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Answer Areca

NEW QUESTION 77
- (Exam Topic 3)

Requirement
Caller states issue. help. or problem.

Bot provides choices

Responses are temporarily saved

Requirement
Caller states issue. help, or problem.

Bot provides choices

Responses are temporarily saved

A company has a portal. Users sign into the portal by using a social media account.
The company wants to replace the existing portal with a Power Apps portal. users must sign up for access to the portal by using a Microsoft account and a unique

invitation code that will be provided to the users.

You need to configure authentication for the home page.

Which values should you use? To answer, drag the appropriate values to the appropriate authentication settings. Each value may be used once, more than once,
or not at all. You may need to drag the split bar between panes or scroll to view content.

NOTE: Each correct selection is worth one point.
Values

=] Mo

A. Mastered
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Answer Area

Node/Function

Tngger phrase

-

ingger phrase

Question
Message
Action

Question
Action

Message
Vanable
Identifier
Action
Vanable

Tngger
Identifier

Node/Function

Tngger phrase

w

Question
Message
Action

Question
Action

L
Message

Vanable
Identifier
Action
Vanable
_Tngger

Authentication setting
Etemnal sign in

Open registration

Value
Vae

Ve
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B. Not Mastered
Answer: A

Explanation:
NO NO

NEW QUESTION 82

- (Exam Topic 3)

The app needs to store temporary data

» Each screen must maintain a separate copy of data and pass the data to another screen.

» The app must be able to update separate rows of a table independently. You need to configure variables for the data.

Which variable types should you use? To answer, drag the appropriate variable types to the correct requirements. Each variable type may be used once, more
than once, or not at all. You may need to drag the split bar between panes or scroll to view content.

NOTE: Each correct selection is worth one point.

Variable types Arawer Arca

Resguirerrseryt Variahls rype

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Graphical user interface, text, application Description automatically generated with medium confidence

NEW QUESTION 83

- (Exam Topic 3)

You are using a development environment to add a new column to a system table. You plan to move the changes to a test environment they are complete.

The changes must meet the following requirements:

» Must be clearly identified so that they are not confused with system components and components from other solutions.

» Must not affect any existing components in the test environment. You need to prepare a solution for deployment to the test environment.

Which four actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

Action Angwed SFER

Q0

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Step 1: Create a new publisher Solution publisher

Every app and other solution components such as entities you create or any customization you make is part of a solution. Because every solution has a publisher,
you should create your own publisher rather than use the default. You specify the publisher when you create a solution.

Step 2: Create a new unmanaged solution and select the correct publisher unmanaged solution

Unmanaged solutions are used in development environments while you make changes to your application. Unmanaged solutions can be exported either as
unmanaged or managed. Exported unmanaged versions of your solutions should be checked into your source control system. Unmanaged solutions should be
considered your source for Microsoft Power Platform assets. When an unmanaged solution is deleted, only the solution container of any customizations included in
it is deleted. All the unmanaged customizations remain in effect and belong to the default solution.

Step 3: Add the table top the solution and add the new column. Step 4: Run the solution checker on the solution

Use solution checker to validate your model-driven apps in Power Apps.

Reference: https://docs.microsoft.com/en-us/power-platform/alm/solution-concepts-alm https://docs.microsoft.com/en-us/power-apps/maker/data-platform/use-
powerapps-checker

NEW QUESTION 87

- (Exam Topic 3)

A company uses Common Data Service to store sales data.

For the past few quarters, the company has experienced a decrease in sales revenue. The company wants to improve sales forecasting.

The company plans to use Al Builder to implement the solution. You select fields that will be used for prediction.

Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.
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Actions Answer Area

Export data from Common Data Service
into Microsoft Excel

Train the category classification Al model
by using Common Data Service data

exported to Microsoft Excel

Train the Al model by using data @

O

Publish the Al model

Use the model with Power Apps

Import the Al model analysis into
Commen Data Service

Train the prediction Al model by using
Common Data Service data

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Graphical user interface, application Description automatically generated

Step 1:

Before you can use your prediction model, you have to train it to perform the way you want. Step 2:
After you train your model, publish it to make it available.

Publish your model when you want to make it available to users in your Power Apps environment. Step 3: Use the model with Power Apps
Reference:

https://docs.microsoft.com/en-us/ai-builder/prediction-train-model

NEW QUESTION 88

- (Exam Topic 3)

A company is creating a canvas app and a model-driven app to manage their customer accounts.

The canvas app requires a business rule to set the Business Type column to large if the customer size is greater than a specific currency value.

The model-driven app requires a business rule to recommend the account rating be re-evaluated when the account goes on credit hold for this app only.

You need to configure the scope for the business rules.

Which scope should you use? To answer, drag the appropriate scopes to the correct business rules. Each scope may be used once, more than once, or not at all.
You may need to drag the split bar between panes or scroll to view content.

NOTE: Each correct selection is worth one point.

Scopes Answer Area
Al forms | Business rule Scope
= Business Type column setting for customer size [
Specific form P 9
| Account rating re-evaluation ‘
Table
A. Mastered

B. Not Mastered
Answer: A

Explanation:
Box 1: Table
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The canvas app requires a business rule to set the Business Type column to large if the customer size is greater than a specific currency value.

Scope the business rule to Entity (Table). Box 2: Specific form

The model-driven app requires a business rule to recommend the account rating be re-evaluated when the account goes on credit hold for this app only.
For Model

The scope of the business rule determines which forms the business rule will be applied. You set the scope, according to the following:

If you select this item... The scope is set to...

Entity- The table and all forms for the table All Forms- All forms for the table

Specific form (account Main Form, for example) - Just that form

Reference: https://debajmecrm.com/business-rules-in-powerapps-canvas-apps/
https://docs.microsoft.com/en-us/power-apps/maker/model-driven-apps/create-business-rules-recommendations

NEW QUESTION 91

- (Exam Topic 3)

You have a canvas app.

The canvas app must store data in a variable that is available only to the current screen. You need to create the variable.

Which two functions should you use? Each correct answer presents a complete solution. NOTE: Each correct selection is worth one point.

A. Navigate

B. UpdateContext
C. Set

D. Collect

E. SaveData

Answer: BC

Explanation:

* B. UpdateContext function can be used to create a variable that is only available to the current screen. This function takes in an object that defines the variable
and its initial value, and updates the context of the current screen with that variable. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/functions/function-updatecontext

* C. Set function can be used to assign a value to a variable. The Set function sets a variable to a specified value, which is useful when you need to update the
value of a variable. Reference:

https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/functions/function-set

NEW QUESTION 94

- (Exam Topic 3)

You are implementing a model-driven app to support a new line of business. There are several places where automated business logic must be applied. You need
to determine how to apply the business logic.

Which method should you use? To answer, drag the appropriate methods to the appropriate business logic statements. Each method may be used once, more
than once, or not at all. You may need to drag the split bar between panes or scroll to view content.

NOTE: Each correct selection is worth one point.

Methods Answer Area
Business rule Business logic Method
Real-ime workflow Make a field read only unhl a predetermined Method

value 15 exceeded

Power Automate instant flow . . .
Automatically send an email when a record’s Method

status 1s changed to deactivated

Use the previous value of a flield when the Method
value 1s automatically updated as part of the

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Graphical user interface, text, application Description automatically generated

Box 1: Business rule

By combining conditions and actions, you can do any of the following with business rules:

> NSE5 FSM-5.2 Set column values

> Clear column values

> Set column requirement levels

> Show or hide columns

> Enable or disable columns

> Validate data and show error messages

> Create business recommendations based on business intelligence. Box 2: Real-time workflow
Real-time workflows:
Graphical user interface, text, application, email Description automatically generated
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Box 3: Power Automate instant flow

Instant Flows don’t have a trigger in the same way as the Automated flow. Instead, they are triggered manually or on-demand, such as a user clicking a Flow
button in the mobile app.

Reference:

https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/create-business-rules-recommendations-a https://docs.microsoft.com/en-
us/powerapps/maker/data-platform/configure-workflow-steps https://carldesouza.com/difference-between-instant-automated-and-scheduled-flows-in-power-
automate-and-ho

NEW QUESTION 98

- (Exam Topic 3)

You plan to create a dataflow by using Power Query to transform the data. You observe that some cells display an error instead of the expected data. You need to
obtain more details about the errors. What should you do?

A. Select the row that includes the cell with the error.
B. Use the Flow Checker.

C. Select the cell with the error.

D. Use the App Checker.

E. Use the Advanced Editor.

Answer: C

Explanation:
When you select the cell with the error, a tooltip will appear with more details about the error. This will help you identify the cause of the error and take the
necessary steps to fix it.

NEW QUESTION 101

- (Exam Topic 3)

You manage the Dynamics 365 Customer Service environment for an organization. Microsoft SharePoint will not be deployed in the environment for a year.
You need to integrate Microsoft Office 365 solutions with the Dynamics 365 instance to help the sales team with internal collaboration efforts.

Which three solutions can you currently implement? Each correct answer presents part of the solution. NOTE:

Each correct selection is worth one point.

NOTE: Each correct selection is worth one point.

A. Microsoft OneDrive for Business
B. Microsoft Yammer

C. Microsoft OneNote

D. Microsoft Skype for Business

E. Microsoft Exchange Online

Answer: BDE
Explanation:

References:
https://docs.microsoft.com/en-us/dynamics365/customer-engagement/admin/add-office-365-online-services

NEW QUESTION 104

- (Exam Topic 3)

A company is updating a Power Apps solution that contains two tables named Sen/ices and Equipment. The company is creating a new solution to update the
current solution for the following requirements:

» The Services table must be updated to include change tracking.
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» The Equipment table must be updated to include four new columns.
* The solution must update only the components that need to be added or changed. You need to create the solution.

Which table option should you use? To answer, drag the appropriate options to the correct tables. Each option may be used once, more than once, or not at all.
You may need to drag the split bar between panes or scroll to view content.

Options Answer Area
nclude all cc mponents Table ﬂptiun
nclude entity metadata services

uipment

i

select components

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Select components Option for Services Table Select components Option for Equipment Table
The "Select components" table option allows you to update specific components of a table, such as adding new columns or change tracking, while keeping the

existing data and relationships in the table intact. This meets the requirement that the solution must update only the components that need to be added or
changed.

You can use the Power Apps maker portal and navigate to the Environment, then click on the Data tab, select the table you want to update and click on the
settings icon and then select "Select components” from the options. Then you can select only the columns you want to add or update for each table.

This way, you can ensure that the solution will update only the necessary components for each table, including change tracking for the Services table and four new
columns for the Equipment table, without affecting the existing data and relationships in the tables.

NEW QUESTION 105
- (Exam Topic 3)
A company is configuring a Power Apps portal using Microsoft Dataverse. The company requires the following:

> Only authenticated users must be able to sign into the portal.
> Authenticated users must have varying degrees of access to the different parts of the portal.

> Users must enter one of several external identities when creating an account during the open registration process.
You need to configure user authentication and permissions.

Which component should you use? To answer, select the appropriate options in the answer area.

NOTE: Each correct selection is worth one point.

Answer Area

Configuration Component

Required for each authenticated user
before security can be assigned.

Contact table record

Local user

Microsoft work or school account
Account table record

Required for authenticated users to
access restricted pages of the portal,

Contact table record
Local user

Microsoft work or school account
Web roles

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Box 1: Contact table record

In Power Apps portals, each authenticated portal user is associated with a contact record in Microsoft Dataverse.
Box 2: Web roles

Portal users must be assigned to web roles to gain permissions beyond unauthenticated users. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/portals/configure/configure-portal-authentication

NEW QUESTION 108
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- (Exam Topic 3)

A Company plans to send escalation emails to all customers with overdue invoices. You are creating a Microsoft Power Automate flow to determine whether to
send an escalation email.

The system must send an alert for all invoices that are seven days or more overdue. You need to configure the flow.

Which expression should you use?

iy

A TriggerEmail() = '"OverdueDate’ >s=

Em by
Py

B "OverdueDate’ »= TriggerEmail() " :false

L. @GreaterOrEquals{TriggerEmail()?[ ' OverdueDate’']: '7")

A. Option A
B. Option B
C. Option C

Answer: C

Explanation:
Example: equals(triggerOutputs()?[‘body/PDFStatus/Value'],’Ready to Generate’) Reference:
https://evolvous.com/microsoft-power-automate-trigger-condition/

NEW QUESTION 113

- (Exam Topic 3)

A company uses model-driven apps.

Users in the sales department enter the first name, last name, and phone number of customers in the app. The users request a single screen in the app to enter
the customer data.

You need to configure the app. What should you do?

A. Create a canvas app.

B. Modify the site map.

C. Create a Power Automate flow.
D. Use a Power Virtual Agents app.

Answer: B

Explanation:

To configure a model-driven app in order to provide a single screen for the sales department users to enter the customer data, you should modify the site map of
the app. A site map is a hierarchical representation of the different areas and functionality of the app, and it can be modified to create a new screen or view that
combines the necessary fields for the customer data entry.

Once the site map is modified, you can add the necessary fields (first name, last name, and phone number) to the new screen or view, and make it accessible to
the sales department users.

References:

> https://docs.microsoft.com/en-us/power-platform/admin/model-driven-apps-overview
> https://docs.microsoft.com/en-us/power-platform/admin/modify-site-map

NEW QUESTION 117

- (Exam Topic 3)

The owner of a company needs to know who signs into the system. You need to ensure that the owner can view the user audit logs.

Where does each action need to be performed? To answer, select the appropriate options in the answer area. NOTE Each correct selection is worth one point.

Action Location

Activate user auditing v
System Settings

Personal Settings

Customize the System
Microsoft 365 Compliance

View the user audit logs v
Advanced Find

Indmdual record

User Summary report
Microsoft 365 Comphance

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Reference:
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https://docs.microsoft.com/en-us/power-platform/admin/audit-data-user-activity

NEW QUESTION 118

- (Exam Topic 3)

A company plans to create two Microsoft Power Platform applications.

One of the applications requires a custom control layout without using code. The other application will be used primarily by external users.

You need to create the applications.

Which application types should you use? To answer, drag the appropriate application types to the correct requirements. Each application type may be used once,
more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.

NOTE: Each correct selection is worth one point.

Application types Answer Area

anvas app

Requirement Application type

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Application types Answer Area

Requirement Application type

Custom control layout without coding f Canvas app
|

Wi g 5

s o i

| MOGE=0TIveEN A0
Wt cla

Jsed by external users o

NEW QUESTION 119

- (Exam Topic 3)

You make the following customizations to a Microsoft Dataverse Environment
* Create a new table

» Add data to the new table.

* Delete an unused area from the site map.

The components must be transported to a different environment.

You need to determine the method required to transport each component.
Which method should you use? To answer, drag the appropriate methods to the correct components. Each method may be used once, more than once, or not at
all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

L L R Arawer Ares

C dsmproarg vl L RN

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Bl b 0 Arywes Rrew

£ cerviganrig il Pkt Fuiead
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NEW QUESTION 120

- (Exam Topic 3)

A company uses Power Apps with Microsoft Dataverse.

The company enables auditing on the Dataverse database. The company tenant reaches the maximum storage capacity.

You need to delete some auditing data.

Which three deletion options should you use? Each correct answer presents a complete solution. NOTE: Each correct selection is worth one point.

A. by table

B. by record

C. between two specified dates
D. by column

E. older than a specified date

Answer: ACE

Explanation:

* A. Deleting by table allows you to select specific tables in the Dataverse database for which you want to delete the auditing data. This can be done by going to
the Power Apps portal, navigating to the Data tab, and selecting the table for which you want to delete the auditing data. You can then select the specific auditing
data you want to delete and click the "Delete" button. This is useful if you want to only delete auditing data for specific tables and not for the entire database.
Reference:

https://docs.microsoft.com/en-us/power-platform/admin/data/data-management-auditing#delete-audit-logs

* C. Deleting between two specified dates allows you to select a range of dates within which the auditing data will be deleted. This can be done by going to the
Power Apps portal, navigating to the Data tab, and selecting the "Audit" option. From there, you can select the "Delete" button, and select the "Between two dates
option. Then you can specify the start and end date for which you want to delete the auditing data. This is useful if you want to delete auditing data for a specific
time period and not for the entire database. Reference: https://docs.microsoft.com/en-us/power-platform/admin/data/data-management-auditing#delete-audit-logs
* E. Deleting older than a specified date allows you to select a specific date, and any data older than that date will be deleted. This can be done by going to the
Power Apps portal, navigating to the Data tab, and selecting the "Audit" option. From there, you can select the "Delete" button, and select the "Older than a
specified date" option. Then you can specify the date for which you want to delete the auditing data. This is useful if you want to delete auditing data that is older
than a certain date and not for the entire database. Reference: https://docs.microsoft.com/en-us/power-platform/admin/data/data-management-auditing#delete-
audit-logs

It's always good to have a backup of Data before deletion and also check the retention period of the data you want to delete.

NEW QUESTION 121

- (Exam Topic 3)

You use Power Bl Desktop to configure Power Bl reports.

You need to create a canvas app that displays user account information and include the app in a Power Bl
report.

Which three actions should you perform? Each correct answer presents part of the solution.

NOTE: Each correct selection is worth one point.

A. From the Power Apps Insert menu, add a Power Bl tile

B. From the Power Bl Desktop menu, insert a Power Apps visual and include the required fields in the Power Apps data
C. Publish the report to the Power Bl service

D. Connect to Common Data Service from Power Bl Desktop

Answer: BCD

Explanation:
Step 1 (B): Here’s how we embed PowerApps into a Power Bl report:

> Download and login to the Power Bl desktop application

> Click on (...) and select “Import from the marketplace.”

Step 2: Open Power Bl desktop and use “Get data” to connect with the Common Data Service data source. Step 3: Publish the report to Power Bl service.
Reference:

https://purple.telstra.com/blog/powerbi-integration-with-powerapps

NEW QUESTION 123

- (Exam Topic 3)

You are a Dynamics 365 Customer Service administrator.

You need to configure the following automation for the sales team:

* Send an email when the status changes on an Opportunity.

* Text the sales manager when an Opportunity is created.

* Create a Wunderlist task when an Opportunity is open for 30 days.

Which tool should you use for each requirement? To answer, select the appropriate options in the answer area. NOTE Each correct selection is worth one point.
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Automation Tool

Email when the status changes. -
Dynamics 365 workflow
Microsoft Flow

Business Process Flow

Text when the Opportunity is created. v
Dynamics 365 workflow
Microsoft Flow

Business Process Flow

Create a Wunderlist task. -
Dynamics 365 workflow

Microsoft Flow
Business Process Flow

A. Mastered
B. Not Mastered

Answer: A
Explanation:
Automation Tool
Email when the status changes. -
Dynamics 365 workflow
Microsoft Flow
Business Process Flow
Text when the Opportunity is created. v

Dynamics 365 workflow
Microsoft Flow
Business Process Flow

Create a Wunderlist task. -

Dynamics 365 workflow
|Mir:.r050ft Flow
|Business Process Flow

NEW QUESTION 124

- (Exam Topic 3)

A company uses Microsoft Teams. You plan to create a Power Apps app for Microsoft Teams. You need to determine the environment that will used by the app.
Which environment will the app use?

A. An existing Dataverse environment that you select.

B. An existing Dataverse for Teams environment that you select.

C. A Dataverse environment that is automatically created for the team.

D. A Dataverse for Teams environment that is automatically created for the team.

Answer: D

Explanation:

The Dataverse for Teams environment is automatically created for the selected team when you create an app or bot in Microsoft Teams for the first time or install a
Power Apps app from the app catalog for the first time. The Dataverse for Teams environment is used to store, manage, and share team-specific data, apps, and
flows. Each team can have one environment, and all data, apps, bots, and flows created with the Power Apps app inside a team are available from that team's
Dataverse for Teams database.

Reference:

https://docs.microsoft.com/en-us/power-platform/admin/about-teams-environment

NEW QUESTION 127

- (Exam Topic 3)

A company creates a canvas app.

The app requires users to enter their social security number. The app should only display the last four digits when the user tabs to a different column.
You need to configure the app. Which option should you use?

A. Power Fx

B. Business rule
C. Business process flow
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D. Power Bl DAX

Answer: A

NEW QUESTION 128

- (Exam Topic 3)

You implement an editable grid for the Account entity.

The business team provides the following list of features that they would like you to implement:

> Group by or sort columns in the current view.

> Configure a business rule to show an error message.
> Edit values in calculated fields.

> Edit the Address composite field.

> Use the editable grid on mobile phones.
Which actions can you perform? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

Action Can be performed?
Group by or sort columns in the current view 4
Yes
No
Configure a business rule to show an error message. i
Yes
No
Edit values in calculated fields. ¥
Yes
No
Edit the Address composite field o
Yes
No
Use the editable grid on mobile phones X
Yes
No
A. Mastered
B. Not Mastered
Answer: A
Explanation:
Action Can be performed?
Group by or sort columns in the current view -
Yes |
No
Configure a business rule to show an error message. hd
Yes,
No
Edit values in calculated fields. i -l
Yes |
No
Edit the Address composite field ol
‘Yes
No |
Use the editable grid on mobile phones hd
L Yes
No i

NEW QUESTION 130

- (Exam Topic 3)

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

You administer the Microsoft 365 and Power Platform environments for Contoso, Ltd. The company has a model-driven app that is used to track customer
interactions with employees. The app uses standard table types for customers. A user named Elisabeth Rice signs in to the app by using the following sign in
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name: Elisabeth.Rice@contoso.com.

After marriage, Elisabeth changes her legal name to Elisabeth Mueller.

You need to update the sign in name for the user without losing any application history. Solution: Change Elizabeth’s username in the user record for the app.
Does the solution meet the goal?

A. Yes
B. No

Answer: A

NEW QUESTION 133

- (Exam Topic 3)

You are a Dynamics 365 Customer Service administrator.

Users report that the main form does not display data from other entities or allow them to edit data from other entities.

You need to embed information from other entities in the form and allow users to edit the data. Which actions should you perform? To answer, select the
appropriate options in the answer area. NOTE: Each correct selection is worth one point.

Requirement Action

Edit data v

Add a mobile form

Add a quick create form
Add a sub-grid

Add a virtual entity

View data 4

Add a reference panel
Add a quick view

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Graphical user interface, text, application, chat or text message Description automatically generated

Box 1: Add a quick create form

With quick create forms, your app can have a streamlined data entry experience with full support for logic defined by form scripts and business rules.

Box 2: Add a quick view

A quick view form can be added to another form as a quick view control. It provides a template to view information about a related entity record within a form for
another entity record. This means your app users do not need to navigate to a different record to see the information needed to do their work.

Reference:

https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/create-edit-quick-create-forms https://docs.microsoft.com/en-
us/dynamics365/customerengagement/on-premises/customize/create-edit-quick-v

NEW QUESTION 136

- (Exam Topic 3)

A company uses Power Apps.

The company plans to create a canvas app that uses a responsive design. You need to configure the app.

Which two actions should you perform? Each correct answer presents part of the solution. NOTE: Each correct selection is worth one point.

A. Enable the lock orientation setting.

B. Configure the height and width properties by using a formula.

C. Disable the Scale to fit setting.

D. Configure the height and width properties by using drag handles.

Answer: BC

Explanation:

To create a canvas app that uses a responsive design in Power Apps, you should perform the following actions:

* B. Configure the height and width properties by using a formula: By using a formula to set the height and width properties, you can ensure that the app will
respond to changes in screen size and orientation. For example, you can use the Width() and Height() functions to set the width and height properties based on
the size of the screen.

* C. Disable the Scale to fit setting: The Scale to fit setting, when enabled, makes the app's content fit on the screen by scaling it down. To create a responsive
app, this setting must be disabled.

Reference:

https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/responsive-design https://docs.microsoft.com/en-us/powerapps/maker/canvas-
apps/functions/function-width

NEW QUESTION 137

- (Exam Topic 3)

You are designing a chatbot for a sports outlet. You need to complete the chatbot.

Which features should you use? To answer, drag the appropriate features to the correct requirements. Each feature may be used once, more than once, or not at
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all. You may need to drag the split bar between panes or scroll to view content.
NOTE Each correct selection is worth one point.

Features Answer Area
_ Requirement Feature
Topics
Enable the chatbot to relate to a real-world object or topic in a Feature
N dialog.
Entities
Define the path and triggers for a chatbot conversation. Feature
Variables
Implement conditional logic to dynamically route a conversation Feature
Flows across different paths.
A. Mastered

B. Not Mastered
Answer: A

Explanation:

Graphical user interface, text, application, email Description automatically generated

Box 1: Entities

Out of the box, Power Virtual Agents comes with a set of prebuilt entities, which represent the most commonly used stereotype information in real-world dialogs,
such as age, colors, numbers, and names.

With the knowledge granted by entities, a bot can smartly recognize the relevant information from a user input and save it for later use.

Box 2: Topics

In Power Virtual Agents, a topic defines a how a bot conversation plays out.

You can author topics by customizing provided templates, create new topics from scratch, or get suggestions from existing help sites.

A topic has trigger phrases — these are phrases, keywords, or questions that a user is likely to type that is related to a specific issue — and conversation nodes —
these are what you use to define how a bot should respond and what it should do.

Box 3: Variables

Variables let you save responses from your customers in a conversation with your bot so that you can reuse them later in the conversation.

For example, you can save a customer's hame in a variable called UserName. The bot can then address the customer by name as the conversation continues.
You can use variables to create logical expressions that dynamically route the customer down different conversation paths.

Reference:

https://docs.microsoft.com/en-us/power-virtual-agents/advanced-entities-slot-filling https://docs.microsoft.com/en-us/power-virtual-agents/authoring-create-edit-
topics

https://docs.microsoft.com/en-us/power-virtual-agents/advanced-flow https://docs.microsoft.com/en-us/power-virtual-agents/authoring-variables

NEW QUESTION 139

- (Exam Topic 3)

A company uses Common Data Service to manage account and contact information. The company plans to use the Al Builder model to make key business
decision.

You need to integrate prebuilt Al Builder models with Power Automate.

Which models should you use? To answer, select the appropriate option the answer area. NOTE Each correct selection is worth one point.

Scenario Model

Extract specific text from a PDF document v
Text recognition model

Key phrase extraction model

Text recognition model and key phrase extraction model

Determine the likelihood that customers will purchase v
additional products Sentiment analysis model

Category classification model

Entity extraction model

Prediction model

A. Mastered
B. Not Mastered

Answer: A
Explanation:
Reference:

https://docs.microsoft.com/en-us/ai-builder/prebuilt-sentiment-analysis https://docs.microsoft.com/en-us/ai-builder/prebuilt-key-phrase
https://docs.microsoft.com/en-us/ai-builder/prebuilt-text-recognition
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NEW QUESTION 142

- (Exam Topic 3)

You are a Dynamics 365 Customer Service system administrator. You create an app for the sales team. Members of the sales team cannot access the app.
You need to ensure that sales team members can access the app. Where should you configure app permissions?

A. Security Roles

B. Manage Roles

C. Dynamics administration center
D. Dynamics 365 home

Answer: B

Explanation:

References:

https://docs.microsoft.com/en-us/dynamics365/customer-engagement/customize/manage-access-apps-security-r Manage access to apps by using security roles.
You can choose what users see and access from the My Apps page or the Customer Engagement home page by giving app access to specific security roles.
Users will have access to apps based on the security roles they're assigned to.

* 1. Go to Settings > My Apps.

* 2. In the lower-right corner of the app tile you want to manage access for, select More options (...), and then select Manage Roles.

* 3. Enter the following in the Manage Roles dialog box:

a) App URL Suffix

b) Roles

c) Select Save.

* 4, Refresh the My Apps page.

* 5. Go to the Apps Being Edited view, and publish the app again. Reference:
https://docs.microsoft.com/en-us/dynamics365/customerengagement/on-premises/customize/manage-access-app

NEW QUESTION 144

- (Exam Topic 3)

You plan to add a Power Apps app to Microsoft Teams.

A Microsoft Dataverse for Teams environment has not been provisioned. You need to create a Dataverse for Teams environment.
Which two actions can you perform? Each correct answer presents a complete solution.

NOTE: Each correct selection is worth one point.

A. Create a new environment in the Microsoft Power Platform Admin Center.
B. Create a new app in Teams.

C. Create an app permission policy in the Teams admin center.

D. Install an existing app in Teams.

Answer: BD

NEW QUESTION 146

- (Exam Topic 3)

You plan to create a Power Virtual Agents bot. The bot has the following requirements:

« Ensure that user responses are available to any topic.

» Recognize a list of words from spoken language of users. You need to configure the bot.

Which features should you use? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.
Answer Area

Requirement Feature

LUiser respanses are avallable 1o any topic

.1'-_1f | ,_1-!_- !I:‘

A. Mastered
B. Not Mastered

Answer: A

Explanation:
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Answer Area

Requirement Feature

Liser responses are available 1o any topic

Recognize a list of words from spoken | Entity v |

language. ToDIC

NEW QUESTION 149

- (Exam Topic 3)

You are designing a Power Virtual Agents chatbot.

The chatbot must be able to maintain customer information if the conversation topic changes during a dialog.

You need to configure variables to store customer name and email address. Which type of variable should you create?

A. session

B. topic

C. bot

D. slot
Answer: C
Explanation:

By default, a variable's value can only be used in the topic where this variable gets created. However, you might want the bot to use the same value across topics.
This means the bot can remember the necessary context when a conversation spans multiple topics. In some systems, these types of variables are known as
global variables. In Power Virtual Agents, these variables are called bot variables, because they apply across the entire bot.

Reference:

https://docs.microsoft.com/en-us/power-virtual-agents/authoring-variables-bot

NEW QUESTION 152

- (Exam Topic 3)

A company uses a model-driven app. The app uses a workflow to send email. Emails are sent to new customers that enter an email address for the first time in the
app.

Customers report that they do not receive an email after entering an email address. You need to troubleshoot the issue.

In which order should you perform the actions? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the correct
order.

T ] HBrewrs e n

>

<

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Actions Angwer ared

NEW QUESTION 155

- (Exam Topic 3)

You use Power Bl Desktop to configure Power Bl reports and dashboards.

You need to create a canvas app that displays account information and include the app in a Power Bl report. Which three actions should you perform? Each
correct answer presents part of the solution.

NOTE Each correct selection is worth one point.

A. Publish the report to the Power Bl service.

B. Connect to Common Data Service from Power Bl Desktop.

C. Connect Common Data Service from Power Bl Deskto

D. Selected required fields from the Accounts table.

E. From the Power Apps Insert menu, add a Power Bl

F. From the Power Bl Desktop menu, insert a Power Apps visual and include the required fields in the Power Apps data.
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Answer: CDE

NEW QUESTION 158

- (Exam Topic 3)

You add a business process flow to the Account table. The flow has three stages. You need to ensure that a workflow can run when a user completes the final
stage. Which option should you use?

A. Start when: Record status changes

B. Available to run: Run this workflow in the background
C. Available to run: As an on-demand process

D. Available to run: As a child process

Answer: C

Explanation:

You can trigger on-demand workflows from inside a business process flow. For example, you can add an on-demand workflow to a business process flow so that
an activity, such as a task or email, is created whenever a stage is completed.

Note: A workflow becomes activated based on where you drop the workflow onto the business process flow designer.

On-demand stage processes. When the workflow is dropped onto a business process flow stage, the workflow is triggered on entry or exit of the stage.
Reference:

https://docs.microsoft.com/en-us/power-automate/bpf-add-on-demand-workflow

NEW QUESTION 160

- (Exam Topic 3)

You create a Power Virtual Agents chatbot to reduce the number of incoming support calls that require a live person.

The chatbot does not direct users to the correct information. You determine that this is because the chatbot is not able to identify which product a user is referring
to in a conversation.

You need to present a list of products so that users can select the correct product. What should you create?

A. Table

B. Variable
C. Slot filling
D. Entity

Answer: C

Explanation:

Slot filling is a natural language understanding concept that means saving an extracted entity to an object. However, in Power Virtual Agents, slot filling means
placing the extracted entity value into a variable.

Reference: https://docs.microsoft.com/en-us/power-virtual-agents/advanced-entities-slot-filling

NEW QUESTION 165

- (Exam Topic 3)

You ate a Dynamics 365 Customer Engagement administrator. You create workflows to automate business processes. You need to configure a workflow to meet
the following requirements:

« Be triggered when a condition is met.

* Run immediately.

» Perform an action when a condition is met.

How should you configure the workflow? To answer, select the appropriate configuration in the answer area. NOTE: Each correct selection is worth one point.

Answer Area
Workflow Requirement Configuration Option

e —

A. Mastered
B. Not Mastered

Answer: A

Explanation:

1) Be triggered when a condition is met - Subject contains data
2) Run Immediately - Configure the workflow to run now

3) Perform an action when a condition is met - send an email

NEW QUESTION 170

- (Exam Topic 3)

A company uses three apps to complete several business processes.

You need to identify solutions to help the company perform regression testing when the apps are updated. Which two tools should you use? Each correct answer
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presents part of the solution.
NOTE: Each correct selection is worth one point.

A. Power Automate automated flow
B. Windows recorder (V1)

C. Power Automate desktop flow
D. Windows Steps Recorder

Answer: BD

NEW QUESTION 173

- (Exam Topic 3)

A company uses a model-driven app. The app uses a Power Virtual Agents chatbot.

The company has two locations in different countries/regions with separate environments for each location. Each location has a development environment, a
testing environment, and a production environment. The company uses the Application Lifecycle Management (ALM) process for the environments.

You need to create the different Power Virtual Agents bot environments. How many Power Virtual Agents bot environments are required?

00 w»
OO WwWN -

Answer: D

Explanation:

When a company uses a model-driven app that incorporates a Power Virtual Agents chatbot, and has multiple locations with different environments for each
location, it is necessary to create separate Power Virtual Agents bot environments for each location.

For each location, 3 different environments are required: development, testing, and production. This is in line with the Application Lifecycle Management (ALM)
process that the company uses.

In total, 6 Power Virtual Agents bot environments are required: 2 locations x 3 environments per location = 6. It's worth mentioning that Power Virtual Agents allows
to export and import the bot, so once you configure the bot in one environment, you can import the bot to the other environments, this way you don't need to start
from scratch.

References:

> https://docs.microsoft.com/en-us/power-virtual-agents/create-bot/bot-lifecycle
> https://docs.microsoft.com/en-us/power-virtual-agents/create-bot/export-import

NEW QUESTION 174

- (Exam Topic 3)

You plan to create a Power Bi dataflow.

The Power Bl dataflow has the following requirements:

« Be able to create a copy of the dataflow to separate Power Bl workspaces

 Schedule the dataflow to update every day at 11:00 AW. You need to configure the dataflow.

What should you do? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.
Answer Area

Requirement Actien

Copy Power Bl datafiow

Schedule updates

Change the properie:

ACd Stréeaming datase?

Cohedule updates I afiaure the Power Bl servce -'|

=4

-
=efresh the rn' toH

Share the dashboards with other users

refresh automan Wiy

A. Mastered
B. Not Mastered

Answer: A

Explanation:
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Answer Area

Requirement

Copy Power Bl datafiow

Schedule updates

Nanag® the wEthing

_hange the properies

Add Streaming dataset

Schedule updates | Configure the Power Bl seny

A

Refresh the history

Power Bl
Share the dashboards ,'“-.

mefresh automatcally

NEW QUESTION 179
- (Exam Topic 3)
You create a Power Platform help Desk solution.

You need to create a dashboard that displays information on help desk cases that are handled each week. Which dashboard components should you use? To

answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.
Requirement Component type

Add a tag chart by using opened cases. v
System chart

Personal dashboard
Area chart

Add a stacked column chart shared with your team. B 4
System chart

Personal dashboard
Area chart

Add a Microsoft Power Bl visualization. v
System chart

Personal dashboard
Area chart

Add a chart from a view that a user creates. v
System chart

Personal dashboard
Area chart

Add a doughnut chart that shows cases by owner. v
System chart

Personal dashboard
Area chart

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Box 1: Area chart Box 2: System chart

System charts are organization-owned charts, which makes them available to anyone with access to read the data running the app. System charts can't be

assigned or shared with specific app users.
Box 3: Personal dashboard Box 4: Personal dashboard Box 5: Area chart
Reference:

https://docs.microsoft.com/en-us/powerapps/user/add-powerbi-dashboards https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/create-edit-

system-chart

NEW QUESTION 184
- (Exam Topic 3)

A company creates a Microsoft Teams app that stores data in two tables in a Microsoft Dataverse for Teams environment.

Users require access to the app and the app data. You need to configure access.

What should you do? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.
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Answer Area

Access

Access 10 the data

Access 10 the app

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Answer Area

HAccess

ACcess 1o the data

Access to the app

NEW QUESTION 186
- (Exam Topic 3)

Action

l Share the data and assign pemmissions

AssIgn a permission 52t for each table in the app.

Create a secunty rale and assign permissions by table,

Share the data and assign PermiSsions.

&l

I Publish the app to a Teams channel

Share with a secunty group
Share with users

Publish the app to a Teams channel.

Action

I_'smlre the datd and assign penmmssions. |

Aszign a permission set for «ach table in the app

Create a secunty role and assign permissions by table,

Share the data and assign penmissions.

&l

4 Publish the app to.a Teams channel

Share with a security group
Share with users

Publish the app to a Teams channel.

A company has a sales application that is supported by an Azure SQL database. You are developing a Power Apps app for use by customer service agents.
The app must reference customer data from the sales application. Data in the sales application is constantly changing and must not be replicated in Microsoft

Dataverse

Some customer data is considered sensitive. You must protect data for specific fields when users view data in the app.
You need to configure table creation for the app.

How should you configure the app? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point

Requirement

Dataverse table type to create for the
referenced customer data.

Protect sensitive customer data for specific
fields

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Requirement

Dataverse table type to create for the
referenced customer data.

Protect sensitive customer data for specific
fields.

Passing Certification Exams Made Easy
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Create a vwtual table,
Create an activity table.
Create a user-owned table

Create an organization-owned table

Create an alternate key.
Lreate a secured column.

implement input method editor (IME) mode

Set the value of the visible property of the fields to false.

Create a user-owned table
Créate an G!g&nl:ﬂhﬂﬂ'ﬂﬁm table

reate an alternatg key. _
Create a secured column. |

implement input method editor (IME) mode.
Set the value of the wisible property of the fields to false.
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NEW QUESTION 190

- (Exam Topic 3)

You have a business process flow.

You need to update the business process flow while minimizing administrative and maintenance efforts. What should you implement? To answer, drag the
appropriate features to the correct requirements. Each

feature may be used once, more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.

NOTE: Each correct selection is worth one point.

Features Answer Area
Action ste -

P Requirement Feature
Classic workflow Allow users to navigate to the previous stage Feature

only from specific stages

Power Automate flow
Create checklist records in specific stages on

Feature
demand
A. Mastered
B. Not Mastered
Answer: A
Explanation:
Features Answer Area
| Action ste .
. =+ Requirement Feature
| Classic workflow | Allow users to navigate to the previous stage | power Automate flow
e i e B only from specific stages. i

' Paower Automate flow e s e s e o
' i - ' Create checklist records in specific stages on | Action step
demand. 4 T P

NEW QUESTION 194

- (Exam Topic 3)

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it As a result, these questions will not appear in the review screen.

On a Contact record, a user creates a Note record that contains the word running.

One week later, the user reports that they cannot find the Contact record associated with the Note record. You need to find the Note record.

Solution: Use Datavserse Search to search for the word run. Does the solution meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 197

- (Exam Topic 3)

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

You administer the Microsoft 365 and Power Platform environments for Contoso, Ltd. The company has a model-driven app that is used to track customer
interactions with employees. The app uses standard table types for customers. A user named Elisabeth Rice signs in to the app by using the following sign in
name: Elisabeth.Rice@contoso.com.

After marriage, Elisabeth changes her legal name to Elisabeth Mueller.

You need to update the sign in name for the user without losing any application history.

Solution: Delete the user account in the Power Platform admin portal and recreate the account by using the new name.

Does the solution meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 201

- (Exam Topic 3)

You are designing a Power Virtual Agents chatbot for a store.

You need to teach the chatbot to acknowledge the store's product categories and the variations within specific categories.

You need to create custom entities to provide the chatbot with the knowledge of the product categories. Which features should you use? To answer, select the
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appropriate options in the answer area.

NOTE: Each correct selection is worth one point.

Answer Area

A. Mastered
B. Not Mastered

Answer: A
Explanation:

Smart match Synonyms Topic

Requirement
Analyze misspellings, grammar variations, and semantic

KAERE S bot smarter by expanding the matching logic.

Extract a category selected by a user during a conversation
into a variable for later use.

https://docs.microsoft.com/en-us/power-virtual-agents/advanced-entities-slot-filling

NEW QUESTION 204
- (Exam Topic 3)

Feature

Slot filling
Synonyms
Smart matching
Topics

Fuzzy matching

slot filling
Synonyms

Topics

Slot filling
Synonyms
Smart matching

Topics

You are creating a Power Virtual Agents chatbot for a Microsoft Power Platform power apps portal app. The job title of users must be stored automatically when
users log in. The job title must always appear in the

chatbot.
You need to configure the job title functionality.
Which mechanism should you use?

A. artificial intelligence
B. variable

C. entity

D. topic

Answer: B

Explanation:

After enabling the Authentication, you will now have access to Two variables, bot.UserDisplayName

bot.Userld
Reference:

https://powerusers.microsoft.com/t5/Power-Virtual-Agents-Community/Getting-User-Details-To-Use-In-Power

NEW QUESTION 206
- (Exam Topic 3)

The business team provides the following list of features that they would like you to implement:

» Group by or sort columns in the current view.

* Configure a business rule to show an error message.

« Edit values in calculated fields.
« Edit the Address composite field.
* Use the editable grid on mobile phones.

Which actions can you perform? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.
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Yes
. ) No
Group by or sort columns in the current view.
Yes
: . No |
Configure a business rule to show an error meessage. |
[ Yes
; ; - No
Edit values in calculated fields
Yes |
Edit the Address composite field. No
Yes
use the editable grid on mobile phones. No |
A. Mastered
B. Not Mastered
Answer: A
Explanation:
_Yes
" ) No
Group by or sort columns in the current view.
Yes,
. No
Configure a business rule to show an error meessage.
Yes
- & - IHQ |
Edit values in calculated fields Ve |
Yes
Edit the Address composite field. INe
_Yes
use the editable grid on mobile phones. | No |

NEW QUESTION 210
- (Exam Topic 3)

You create a canvas app for a sales team. The app has an embedded Power Bl tile that shows year-to-date sales. Sales users do not have access to the data
source that the tile uses.

Sales team users must be able to see data in the Power Bl tile. You must minimize the level of permissions that you grant and minimize administrative overhead.
You need to share another Power Bl component to make the data visible. What should you share?

A. The Power Bl dataset the tile uses as a data source.
B. The Power Bl workspace that includes the tile.
C. The Power Bl dashboard that includes the tile.

Answer: C

Explanation:

Once shared, the PowerApps app will be accessible by all users who have permissions to access the app. However, in order to make the Power Bl content visible

to those users, the dashboard where the tile comes from needs to be shared with the user on Power BI. This ensures that Power Bl sharing permissions are
respected when Power BI content is accessed in an app.
Reference:

https://powerapps.microsoft.com/en-us/blog/power-bi-tile-in-powerapps/

NEW QUESTION 215

- (Exam Topic 3)

A car dealership has a Dynamics 365 Sales environment for its sales company and another environment for its leasing company. Users in one environment must
not be able to see the other environment. You need to grant salespeople access to the sales company environment. What should you do?

A. Add salespeople to a security role.

B. Set privileges.

C. Add salespeople to an Office 365 security group.
D. Set app security

Answer: C
Explanation:

Reference:
https://docs.microsoft.com/en-us/power-platform/admin/control-user-access

NEW QUESTION 220
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- (Exam Topic 3)

You are a Dynamics 365 for Customer Service developer.

You must trigger a mobile notification whenever a specific hashtag is posted from Twitter. The natification will send email to the company’s social media teams
distribution list.

You need to create a connection to the Twitter service and build a solution.

Which four actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

Actions Answer Area

Sign in to the Business platform admin center and create a new
project and connection set

Create a tngger to search for the new posts with the hashiag
Create an action to send a mobile notification

Sign in to Power Automate and create a new blank flow

QLe

Create a tngger to send a mobile notification

Select the social media connector, generate an authentication key
from the service, and enter the key for the connection

Create an action to search for the new posts with the hashtag

Select the social media connector and enter the user credentials
for the connection

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Actions Answer Area

| Sign in to the Business platform admin center and create a new
| project and connection set - I Sign in to Power Automate and create a new blank flow

e S i+ il s I " i S Rl |

: Create a tngger to search for the new posts with the hashtag A ——
e e e e e ' Select the social media connector and enter the user credentials I
| for the connection I

- == — = == T W e — B e R |

| Create a tngger to send a mobile notification
CER = g o = = . = g = e s = 1 ]

Select the social media connector, generate an authentication key | | Create atngger to send a mobile notification

- - - -

| Select the social media connector and enter the user credentials |
|_for the connection. _ _ _ '

NEW QUESTION 223

- (Exam Topic 3)

A company is developing several Power Virtual Agents chatbots. The company manufactures more than 1,000 different products.
The chatbots must prompt users to enter or select a product.

You need to store the model information so that it can be reused across all chatbots. Where should you store the model data?

A. Global variables

B. Custom entities

C. Topics

D. Multiple choice options

Answer: A

NEW QUESTION 228

- (Exam Topic 3)

A company uses a model driven app.

The company needs to automatically update the Status column in real time. You need to configure this feature.
Solution: Create a flow that has an Update a row action. Does the solution meet the goal?
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A. Yes
B. No

Answer: B

NEW QUESTION 229

- (Exam Topic 3)

A company uses Common Data Service to manage prospects. The company has a business process flow named BPFA that is associated with the Prospect entity
to streamline the prospect management process.

You add a field named Category to the Prospect entity. You create additional business process flows. You apply the business process flows to Prospect records
based on the selected category. Users can switch to any other newly configured business process flows but must not use BPFA.
You need to configure the solution.

What are two possible ways to achieve this goal? Each correct answer presents a complete solution. NOTE Each correct selection is worth one point.

A. Remove all of the privileges for BPFA.

B. Deactivate BPFA.

C. Use a business rule to prevent users from switching to BPFA.

D. Change the display order of the business process flows to move BPFA to the bottom of the list.

Answer: AB

NEW QUESTION 233

- (Exam Topic 3)

You are setting up Power Apps security for a company. The company has a CEO, two vice presidents, and 10 managers. Five support representatives report to
each manager.

You set up Manager Hierarchy so managers are able to view data only for the representatives who report to them. The CEO must be able to view all data for
everyone. All support representatives must be able to view customer information in each other’s data across all managers.

You need to resolve issues that arise during testing.

What should you do? To answer, select the appropriate options in the answer area.

NOTE: Each correct selection is worth one point.

Issue Action

Managers are unable to view all their

feport data Add the manager's name to the representative’s user record.

Change the Manager Hierarchy depth to 2.
Move the manager and reports to a separate business unit.
Set up a position in hierarchy.

The CEOQ is unable to view

ive fdata | [T ) f .
representative data but canview — Add the CEO to the representative user record as a manager.
manager data. Change Manager Hierarchy depth to 3.
Create team security.

Five support representatives can view

only their own data, Add the manager's name to the representative's user record,

Add users to field security.
Set up a position hierarchy.

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Box 1: Move the manager and reports to a separate business unit.

Keep the Manager hierarchy, and put the reports to the appropriate business unit.

Note: Two security models can be used for hierarchies, the Manager hierarchy and the Position hierarchy. With the Manager hierarchy, a manager must be within
the same business unit as the report, or in the parent business unit of the report’s business unit, to have access to the report’s data. The Position hierarchy allows
data access across business units. If you are a financial organization, you may prefer the Manager hierarchy model, to prevent managers’ accessing data outside
of their business units. However, if you are a part of a customer service organization and want the managers to access service cases handled in different business
units, the Position hierarchy may work better for you.

Box 2: Add the CEO to the representative user record as a manager. Set up Manager and Position hierarchies

The Manager hierarchy is easily created by using the manager relationship on the system user record. You use the Manager (ParentsystemuserID) lookup field to
specify the manager of the user.

Note: Depth is used to limit how many levels deep a manager has Read-only access to the data of their reports. For example, if the depth is set to 2, the CEO can
see the data of the VP of Sales, VP of Service and Sales and Service Managers. However, the CEO doesn’t see the Sales data or the Support data.
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Box 3: Add users to field security
Power Platform's field-level security lets you set which fields users can see or edit. Reference: https://docs.microsoft.com/en-us/power-platform/admin/hierarchy-
security https://docs.microsoft.com/en-us/power-platform/admin/field-level-security

NEW QUESTION 235

- (Exam Topic 3)

You have a canvas app that allows users to view, select and purchase products. The app uses a Gallery control to display products and checkboxes that allow
users to select products.

When users select items from the product catalog, they move to a different screen to complete a purchase. Users must be able to clear all product selections when
they click the button.

You need to configure the button. What should you do?

A. Use the Reset (Control) formula and pass the gallery control as a parameter to the Reset formula.

B. Use the Reload(control) formula and pass the gallery control as parameter to the Reload formula.

C. Use the ForAall() function to iterate through each item of the Gallery and clear user selections.

D. Set the OnCheck value to populate a collection and the OnUncheck value to remove the item from the collectio
E. Clear the collection when the user selects the button.

Answer: D

Explanation:
https://debajmecrm.com/quick-tip-resetting-controls-inside-gallery-in-canvas-app/

NEW QUESTION 239

- (Exam Topic 3)

You create a Power Automate flow as part of a managed solution. The flow alerts users when files are uploaded to a SharePoint location.

Files are uploaded to SharePoint at a much higher rate than expected. Users report that they receive too many notifications about uploaded files.
You need to stop the flow and correct the issue.

What should you do? To answer, select the appropriate options in the answer area.

NOTE: Each correct selection is worth one point.

Requirament Action

Disable the flow in the managed solution v
Disable the flow from the Power Automate portal

Disable the flow from the Azure portal

Disable the fiow from the Power Automate solution

Verify changes to the flow v
Run the Flow checker and then turmn on the updated flow

Use the Test feature on the updated fiow and then turn on the flow

Turn on the fiow and then use the Test feature for the updated flow

Run the Flow checker and then use the Test feature on the updated flow

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Graphical user interface, text, application Description automatically generated
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Reference:
https://docs.microsoft.com/en-us/power-automate/edit-solution-aware-flow https://docs.microsoft.com/en-us/power-automate/error-checker

NEW QUESTION 243

- (Exam Topic 3)

Your organization does not permit the use of custom code for solutions. You need to create a view that can be viewed by all users in an organization. Where
should you create the view?

A. Microsoft Visual Studio
B. Maker portal

C. Advanced Find

D. System Settings

Answer: B

Explanation:
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/create-edit-views-app-designer

NEW QUESTION 244

- (Exam Topic 3)

A company’s sales staff wants a simplified way to manage their opportunities in Dynamics 365 Sales without adding custom code.
You need to provide a solution for each requirement.

Which solutions should you provide? To answer, select the appropriate options in the answer area.

NOTE: Each correct selection is worth one point.

Requirement Solution

Drag and drop opportunities to change the stage -
Add a Kanban control
Add a Timelne control
Add an Editable Gnd control
Add a Calendar control

Show each salesperson their opportunities in -
I':fll'l{'”‘“j‘-l‘r and Kanban view Add both controls to a custom view

Add both controls to the My Opportunities view

Add one control to All Opportunities and a custom view

Add one control to My Opportunities and a custom view
Show each salesperson the number of open v

pportunities by stage in a standard view Use the List view

Use the Timeline conlrol
Use the Kanban control

use the cnart pane on the view

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Graphical user interface, text, application, email Description automatically generated

Box 1: Add a Kanban control.

The Kanban view allows your sales team to move opportunities from one stage to another by simply dragging them.
Box 2: Add both controls to the My Opportunities view.

> Kanban views help salespeople to manage their opportunities and activities effectively. Add the Kanban control to the Opportunity and Activity entity so
salespeople can use the Kanban views.The Kanban control works only on the Opportunity and Activity entities.

> If you use unified interface, you can display any record in a calendar view via the calendar control.

- Go to Settings->Customization->Customize the System

- Open the configuration for the entity that you want to use the calendar control (Opportunities in our example)
- Click the View tab

- Click “Add Control” and select the calendar control.

- Click the dot for every interface from which you want the calendar control to be available.

Box 3: Use a List view

opportunities in Dynamics 365 Sales

Reference:
https://docs.microsoft.com/en-us/dynamics365-release-plan/2020wavel/dynamics365-sales/work-opportunities- https://crmtipoftheday.com/1206/view-any-
dynamics-365-record-on-a-calendar/
https://fivep.com.au/how-to-get-visibility-and-report-on-an-opportunities-active-current-sales-stage-without-cod

NEW QUESTION 249

- (Exam Topic 3)

A company is implementing Power Apps and Power Automate.

Several components are created within Power Apps. Microsoft Dataverse. and Power Automate. These components must be promoted from the development
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environment to the user acceptance test environment in a single solution package.
You need to create the solution package for promotion. Where should you create the package?

A. Office 365 admin center

B. Azure DevOps

C. Power Apps designer

D. Microsoft Power Platform admin center
E. Azure portal

Answer: D

Explanation:

A solution package is a bundle of components, such as Power Apps, Power Automate, and Microsoft Dataverse, that can be promoted from one environment to
another. To create the solution package for promotion in a company that is implementing Power Apps and Power Automate, the package should be created in the
Microsoft Power Platform admin center.

In the Power Platform admin center, you can create a solution package that includes the necessary components and export it as a .zip file. This file can then be
imported into the desired environment, such as the user acceptance test environment, to promote the components.

References:

> https://docs.microsoft.com/en-us/power-platform/admin/solutions/create-solution
> https://docs.microsoft.com/en-us/power-platform/admin/solutions/import-solution
> https://docs.microsoft.com/en-us/power-platform/admin/solutions/export-solution

NEW QUESTION 251

- (Exam Topic 3)

A company has marketing teams for different regions.

A user creates and publishes a chatbot within Microsoft Teams for their specific marketing team. The base metrics retrieved by the chatbot are relevant to all
marketing teams.

The other marketing teams request access to the chatbot. You need to publish the chatbot to the entire company. What should you do?

A. Configure the chatbot to be used with the Teams channel.

B. Submit the chatbot for admin approval.

C. Copy the published chatbot link and email it to the other teams
D. Invite the other teams to the team that has the chatbot.

E. Export the chatbot and import it into a corporate environment.

Answer: B

Explanation:

Show to teammates and shared users

You can share your bot by adding it to the Microsoft Teams app store, Built for your org > Built by your colleagues section. Only your teammates and shared users
will find the bot there.

Important

Only teammates or shared users can find and install the bot in the Microsoft Teams app store Built by your colleague section. The bot will not show for everyone in
the organization even if it is configured to allow everyone to use the bot. To show the bot to the organization, submit the bot for admin's approval to show in
Microsoft Teams app store Built by your org section.

Reference:

https://docs.microsoft.com/en-us/power-virtual-agents/teams/publication-add-bot-to-microsoft-teams-teams

NEW QUESTION 256

- (Exam Topic 3)

A company has a model-driven app that uses Microsoft Dataverse.

Users need to add an alternate phone number when entering their account information. The users also require a list that displays the customers that do not have
an alternate phone number.

You need to enable the required features.

Which features should you use? To answer, drag the appropriate features to the correct requirements. Each feature may be used once, more than once, or not at
all. You may need to drag the split bar between panes or

scroll to view content.

Features Answer Area

able Requirement Feature
Add altermmate phone number

List of customers without alternate

Lolumn phone number

A. Mastered
B. Not Mastered

Answer: A

Explanation:
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Features Answer Area
. Requirement Feature
A~ Add altermate phone number I i J
List of customers without alternate ey I
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NEW QUESTION 260

- (Exam Topic 3)

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

You are creating Power Virtual Agents chatbot that captures demographic information about customers. The chatbot must determine the group a customer belongs
to based on their age. The age groups are:

2 0-17

> 18- 25

> 26-35

> 36-55

> 55-100

You need to configure the chatbot to ask a question that can be used to determine the correct age group. Solution: Use multiple choice for Identify in the question
and create options that represent of the age groups. Does this meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 265

- (Exam Topic 3)

You have a canvas app with an embedded Power Bl tile.

You share the canvas app. Users report that they are unable to access the Power Bl content. You need to determine why users are unable to access the content
What is the cause of the user s problems?

A. The Power Bl dashboard is not shared.

B. The Power Bl interactions property on the Power Bl tiles is set to Off.

C. The Power BI connection is not shared.

D. The Power BI Display mode property on the Power Bl tiles is set to Disabled

Answer: A

Explanation:

When embedding a Power Bl tile in a Canvas app, there are several factors that must be considered in order to ensure that users have access to the content. One
of the most important is sharing the Power Bl dashboard that the tile is embedded in. If the dashboard is not shared with the users, they will not be able to view the
content in the tile.

To share a Power Bl dashboard, you must have the "Edit" permission for the dashboard. Once you have this permission, you can share the dashboard with other
users by following these steps:

> Click the "Share" button in the top-right corner of the dashboard.
> In the "Share" pane that appears, enter the email addresses of the users that you want to share the dashboard with.

> Select the level of access that you want to grant to the users. You can choose to give them "View" access, which allows them to view the dashboard but not
make changes, or "Edit" access, which allows them to view and make changes to the dashboard.

> Click the "Share" button to share the dashboard with the users. Additionally, there are other factors that could cause user's problems:
> B. The Power Bl interactions property on the Power Bl tiles is set to Off. In that case, the user's won't be able to interact with the visuals.
> C. The Power Bl connection is not shared. In that case, the user's won't have the access to the data source

> D. The Power BI Display mode property on the Power Bl tiles is set to Disabled, in that case the user's won't see the tile
It is important to check all of these factors and ensure that they are properly configured in order to ensure that users have access to the content.
References:

> https://docs.microsoft.com/en-us/power-bi/service-admin-share-dashboard
> https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/embed-power-bi
> https://docs.microsoft.com/en-us/power-bi/service-embed-content/embed-in-powerapps

NEW QUESTION 267
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